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Two trains move towards each other at speeds
70 km/h and 50km/h. If distance is 240km,

when will they meet?
(A) 1.5hours

(B) 2hours

(C) 2.5hours

(D) 3hours

Find the next letter : A, C, F, J, O, ?

(A) T

B) U

©) S

(D) R

The price of a product is increased by 25% and

then decreased by 20%. What is the net

percentage change?

(A) 0%

(B) 2% increase

(C) 5%decrease

(D) 10% increase

Asumis divided among A, B and C such that A

gets 20% more than B and B gets 25% more
than C. If C gets Rs. 2000, what is A's share?

(A) Rs.3000
(B) Rs.3200
(C) Rs.3600

(D) Rs.4000
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& 3 70 R A v 50 B e & afy @
TH-ZE Bl AR ¢ W@ 31 AR g 240 fd. B,
@ T F9 el?

(A) 1.542
(B) 272
(C) 2542
(D) 362

ST & 1 8rm : A, C, F, J, 0, 7
(A) T

(B) U

©) S

(D) R

et I A1 M Ted 25% der SRl @ ofiX

X 20% e ot 21 g wfase oRad
&7

(A) 0%
(B) 2%df=
(C) 5% =t
(D) 10%3fs
U 9 B A, B AR C § 39 g dier ™ &
A% B ® 20% afE ik B & C & 25%

Jifas fyem afs C & Rs. 2000 i, o A &t
fewr @ e

(A) %. 3000
(B) %.3200
(©) %.3600

(D) %.4000
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Pointing to a woman, Ramesh says, "She is the
mother of my son's mother." How is the woman

related to Ramesh?

(A) Wife

(B) Mother

(C) Mother-in-Law

(D) Grandmother

If a person walks 15 km. South, then 10 km.

West, then 15 km. North, how far and in which

direction is he from the starting point?

(A) 10km. West

(B) 15km. East

(C) 25 km. West

(D) 5km. East

Which new policy was introduced by the

Government of India in 2025 to promote electric

vehicles?

(A) FAME-II

(B) National EV Policy 2025
(C) Make inIndiaEV

(D) Green Mobility Scheme

Which Indian State declared 2025 as the 'Year

of Tourism'?

(A) Kerala

(B) Rajasthan

(C) Himachal Pradesh

(D) Goa
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T Afear # ST IR HA Y WA FeA 8,
“qe B I 1 W B AT 81”7 I8 Ao WA F BE
yFR Hefta 87

(A) et
(B) AT
(C) 91
(D) =
HE A 15 B afor, T 10 B ofyam

Al 5T 15 fodl. SR 31 ol gear 21 98 o
TR T @ R g o e R & 37

(A) 10 fofr afsem
(B) 15 fh @@
(C) 25 fofr ufgem
(D) 5l gd

ARG AR &R 2025 ¥ gafdesd aredt & 9gmEn
N 3 R P T A gE B

(A) FAME-II

(B) T &t Hf 2025

(C) "% & gfean i

(D) ¥ wifaferdt Fis

P AR T A 2025 @ “gdes qi” aifta
fopa?

(A) &%

(B) Tt

(C) Bwr=a west

(D) Mar
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10.

11.

What is the theme of International Yoga Day
2025 in India?

(A) Yoga for Health

(B) Yoga for Wellness

(C) Yoga for Global Harmony

(D) Yogaand Environment

Which Indian city became the first to haveé
24x7 water supply system in 20257

(A) Pune

(B) Surat

(C) Bhopal

(D) None of'the above

Which city hosted the G20 Summit in 2025?

(A) Mumbai
(B) New Delhi
(C) Hyderabad

(D) None ofthe above

. Which city hosted the 2025 National Games of

India?

(A) Lucknow
(B) Ahmedabad
(C) Guwahati

(D) None ofthe above

BCA
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9.

10.

11.

12

AR | 2025 % JaUsg A Rag @ &9m
Ai?

(A) @ & ferd am
(B) FAm & fod am
(C) e wmise & R 9
(D) g iR wgET |

2025 B & WRAE MET 24x7 S Sgfe
JoTfeil alell Yl ST8Y &17

A) g

B) @

(C) e

(D) ST F & #E T

2025 @1 G20 e g0 8 e § s
ga?

(A) 948

B) 7E Rt

(C) EERE

(D) IR § 7 FE T

2025 % TS Sl F A fHH TET F g’

(A) TE&TH
(B) STEHEEIE

(C) Famwr

(D) 39 & & FE e

PT.O.
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£

Choose the synonym of "Wise"":

(A) Foolish
(B) Intelligent
(C) Ignorant

(D) Slow

"

. Choose the antonym of "Early" :

(A) Late
(B) Soon
(C) Quick

(D) Before

Select the correct preposition :
Heisfond _ music.

(A) of

(B) in

(C) with

(D) on

Select the correct sentence :
(A) She don't like tea.

(B) Shedoesn't likes tea.
(C) Shedoesn't like tea.

(D) Shedon't likes tea.

Choose the correct spelling :
(A) Acheivement
(B) Achievement
(C) Acheavement

(D) Achivement

BCA
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18.

19.

20.

21.

22,

‘T’ 69 TR i Ha 27
(A) eAferar=e

(B) snferarass

(C) waar=

(D) #& &

e 9§ B A A 27
(A) 2z

(B) @4y

(C) wgsiife

(D) ey

What does "USB' stand for?
(A) Universal Serial Bus

(B) United System Base

(C) Unique Signal Bus

(D) Ultra Speed Board

What is the process of starting a computer
called?

(A) Shutdown

(B) Booting

(C) Loading

(D) Formatting

What is the function of a USB port?
(A) Power supply

(B) Video output

(C) Data Transfer

(D) Processing

BCA
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‘gEE’ TR T @ g 27
(A) A
(B) Swfcrara
(C) waar=s
(D) # T

‘EY = F P A1 g 87
(A) Z&

(B) ®Hamg

(C) wgsife

(D) Tgey
'USB' & I°f &Y 1 27

(A) Fada diftaa aa

(B) gee fowen w9

(C) e forea am

(D) sregT i 9

. FYS Pl A FA B AT B FT Fed 27

(A) =TS

B) fn

(C) i

(D) wiEfET

USB @¢ & & a1 27
(A) Uit Haig

(B) difear smIeye

(C) 2T gimw
(D) "rafET

PT.O.



23.

24.

a3

26.

What does BIOS do in a computer?
(A) Boot System

(B) Store files

(C) Display content

(D) Connectto Internet

What is the default font in MS Word 20162
(A) TimesNew Roman

(B) Arial

(C) Calibri

(D) Verdana

Which function is used to join two or more
strings in Excel?

(A) CONCATENATE

(B) JOIN

(C) MERGE

(D) COMBINE

What is the shortcut key to insert a new
worksheet in Excel?

(A) Ctrl+N

(B) Ctrl+ Shift+N

(C) Shift+F11

(D) Alt+N

- Whatis the purpose of the "Slide Sorter" view

in PowerPoint?

(A) Toview slides in a grid format
(B) Toapply slide transitions

(C) Toadd Speaker notes

(D) Toinsert multimedia elements

BCA
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23,

24.

25,

26..

27.

FgeX § BIOS &1 71 Fd &7
(A) ge faeen

(B) WETH TR FA

(C) amft K@

(D) gete | FAae HE

MS Word 2016 ¥ Wi Wi HiF-a1 87
(A) TimesNew Roman

(B) Arial

(C) Calibri

(D) Verdana

Excel # a a1 & & iy g @t siiew & ot
HI-H BRI ITART Bl 27

(A) CONCATENATE

(B) JOIN

(C) MERGE

(D) COMBINE

Excel # 2 offe Sfiigq @i siféwe Fuit 7 87

(A) Ctrl+N

(B) Ctrl+ Shift+N

(C) Shift+F11

(D) Alt+N

PowerPoint & "Slide Sorter" & & &3
27

(A) wiEe & e wew § @

(B) gifre @R &

(C) ¥t Fgd S

(D) #edrifear da sigar

Contd...



28. How can you insert a page number in Word?

(A) Insert>Page Number
(B) Layout> Page Number
(C) View > Page Number

(D) Home >Page Number

29. Which key is used to refresh the browser?

(A) F2
B) F5
(C) FI2

(D) Fl

30. Operating system actsasa:
(A) Hardware
(B) Interface
(C) Memory

(D) Monitor

31. Whatis Phishing?
(A) Game
(B) Virus
(C) Online Fraud

(D) Encryption software

(A) Python
(B) Java
(C) HTML

(D) MS Excel

BCA

32. Which is nota programming language?

[91

28. Word § U1 Fa¥ 39 T &7
(A) Insert>Page Number
(B) Layout> Page Number
(C) View > Page Number

(D) Home > Page Number

29.
(A) F2
B) F5
(C) F12

(D) FI

30. sifqiferr fowew @ & ?
(A) BEam & &9 |
(B) %49 & &9 |
(C) 39rh % =7 ¥
(D) HieT & =9 &

31. ffsir @ 37
(A) &
(B) am@wd
(C) Sl damg!
(D) uf=pe HiFeaaT

32. o § | S i A 8 87

(A) Python
(B) Java
(C) HTML

(D) MS Excel

e F fober F @ g @ B

PTO.



33.

34.

What is cloud computing?

(A) Using computer during rain

(B) Using remote servers via internet
(C) Desktop installation

(D) Offline data sharing

What is the full form of ISP?
(A) Internet Service Provider
(B) Internet Sharing Protocol
(C) Internal System Process

(D) Information Security Program

. Inprogramming, a variable is used to :

(A) Store data
(B) Perform loop
(C) Defineclass

(D) Create output

Which keyword is used to define a function in

Python?
(A) def
(B) function
(C) define
(D) fun

. Which loop checks the condition before

executing the body?
(A) for

(B) while

(C) do-while

(D) foreach

BCA
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33.

34.

36.

FASE HYET F 27

(A) T | FGX H ITER

(B) detie & wream @ fReie @ & S
(C) ey e

(D) Sl Sar i

ISP &1 qvf &9 1 87
(A) geTe @ar HeEm
(B) gewde A M
(C) et foreed
(D) T GE FHA

. et § e & SwEr ety e o &7

(A) a1 F G992d I B A
B) q T 3 R

(C) F™ Rt #1 & ol
(D) deeye T H & o

Python ¥ %a=T &1 qRafdd & & 08 SF-a1
Fae IUGRT A Siar 27

(A) def

(B) function

(C) define

(D) fim

P A U AL F TR A e IS AF
T &7

(A) for

(B) while

(C) do-while

(D) foreach

Contd...



38.

%

40.

41.

42.

Which error occurs when dividing by zero?
(A) TypeError

(B) IndexError

(C) ZeroDivisionError

(D) ValueError

Which function is used to open a file in Python?

(A) openfile()
(B) file.open()
(C) open()
(D) fopen()

Which of these is not a valid Python identifier?

(A) value
(B) value I
(C) Ivalue

(D) value

What is the purpose of cache memory?
(A) Store permanent data
(B) Increase display quality

(C) Provide fast access to frequently used
data

(D) Connectto internet

Which is the fastest memory?
(A) RAM

(B) ROM

(C) Cache

(D) Hard Disk

BCA
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38.

9,

40.

41.

42.

A 8 ReeE $0 w - e o 27
(A) TypeError

(B) IndexError

(C) ZeroDivisionError

(D) ValueError

Python & %&@ @M & ford B9-81 $awF 990
o e 7

(A) openfile()

(B) file.open()

(C) open()

(D) fopen()

/1 & & @9-@ 99 Python eaEHAt
(identifier) =& &7

(A) value
(B) value I
(C) Ivalue

(D) value

F9 A B gEd Red a4 27
(A) T 22 W H
(B) feeat Fanferdt SgmT

(C) -9 I@GM BN a8 aF oo Ugd
TG BT

(D) 3T | Frae &

HEE O HRA M- A 27
(A) RAM

(B) ROM

(C) Cache

(D) Hard Disk

PTO.



43.

44.

45.

46.

47.

MICR is mostly used in :
(A) Schools

(B) Banks

(C) Hospitals

(D) Airports

Which of the following is system software?
(A) MS Excel

(B) MS Word

(C) Windows OS

(D) Photoshop

Which one is an example of proprietary
software?

(A) Linux

(B) Libre Office

(C) Windows

(D) Apache

Which software is used for online meetings?

(A) VLC
(B) Excel
(C) Zoom

(D) Paint

Which of the following is not a utility software?
(A)‘ Disk cleaner

(B) Defragmenter

(C) Antivirus

(D) MS Paint

BCA
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43,

44.

45.

46.

47.

MICR & g8 aifes gwam fead & &7
(A) =l &

(B) ol &

(C) Sregara |

(D) & @iEl §

fr & & @ faeen dfredaw 87

(A) MS Excel

(B) MS Word

(C) Windows OS

(D) Photoshop

frr & & #9-81 gwEed dweday (@fhd
HiFedaT) F IR o7

(A) Linux

(B) Libre Office

(C) Windows

(D) Apache

AR HifeT & ol $9 @1 giteddy ST
fear frar 27

(A) VLC
(B) Excel
(C) Zoom

(D) Paint

Fret # & f-an giefadt diveday @i 87
(A) Disk cleaner
(B) Defragmenter
(C) "Antivirus
(D) MS Paint
Contd...



48. What s the function of a software patch?
(A) Virusremoval
(B) Adding security updates or fixes
(C) Disk formatting

(D) Filesharing

49. What does cross-platform software mean?
(A) Works only in windows
(B) Works only on mobile
(C) Works on multiple OS

(D) Works offline only

50. A bug in software means :
(A) Avirus
(B) A spellingmistake
(C) Anerrorin code

(D) A graphic glitch

BCA
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48.

49.

50.

HiFedat Y9 (patch) & #41 &6 27
(A) aETH &M

(B) G SMUST A G e
(C) Fw wiffe FEw

(D) B HEH HT

PIE-TICHH HiFeaay & onf &7
(A) ®ad windows ¥ P FHear 2
(B) @aw AeEe # FH Fear ¥
(C) & offfen e W Fd & @
(D) @aa e & Hr &

Higedqy § ‘U H o @ E?
(A) & IJEH

(B) TF gaHl @ T

(C) #is T Ffx

(D) =i T



Rough Work

[14]



Rough Work

[15]



AWIAR. &F § TR e F@ 3 A oaws oy

(-

aS e / IMPORTANT INSTRUCTIONS

. orell F STEEIB-12345, g #e-1017, W QRaH G-P, ¥ Ras den-98785, afy -GEN
fT-MALE 2 & dfaet & fre war & o o st & @ 4

If Candidate's Roll No.-12345, Course Code-1017, Question Booklet Series-P, Question Booklet No.-98765,
Caste Category-GEN. and Gender-MALE then write in the box as indicated below and darken the ovals accordingly.

4. Question 6. Caste

1. Roll No. 3. Course Code Booklet Series 5. Question Booklet No. Category 7.Gender
) T2 (o] [o] [s/) [of (o) (o) [P (\ls] [8] [2] [e] [s]]|[cEn]{mate]
©@ 0 © O O @ © ©| @ |© @ © © ©|EN@®|| wue
® OO 0 e © e @ ONONONMONO, &
@ @0 @ @ I @ @ @ @ @ @ @ @
® ©® 0 0 0|l ® @ ®| O @ ® 6 @ @k O
ONONON OHIOMONONO) @ ® 6 6 6 Female
® ® 6 @ @ ® ® 6 ® ® ® ® @ O
® ® ® ® ®|® ® ® ®|| RO ® ® ® @ ©®|s O
@0 00 0|l @ @ @ @ © @ ® @
® @ ® ® ® R
® ® @ @ O/@ ® ® ®| O ®@ ® ® ® @Ol O
e o e Fr Yy
Method for marking answer :

w2 fafy Teld fafer

Correct Method Wrong Methods

® ® © o] [@ @ © Pl ®m ©® Ol @ © ©® ® © O]

PO IA-TE § ol gfaftedl A @ fad FeAw T @ A ade W oa & s Bt e R @ wer & s o
3 O AW W RA oW $ A uRfe gedl oo w9 o 3 o wRfed w4 ¥ @ ond wea § g I

T TR fer s

Please use only black/blue ball point pen for making all entries in the Answer Sheet which includes darkening
of the ovals. Entries once made can not be changed. Replacement Answer Sheet will not be provided if
incorrect entry is made by the candidate.

W I A R @ Gm R o, o gu g aC A R s w8 o o B o 7 8% w R
e ga W& A aEm

This Answer Sheet will be system processed. Hence please ensure that the entries are correct and complete,
falling which, the system will not capture the desired information.

FH - AR fieen & Ge So-TE W e-YRad wides @ dig 3

Please handover the OMR Sheet and Question Booklet to the invigilator before leaving the examination hall.

SO § BE f o FMas w8 ) B i o @, o Aeie, SeRd AR & s anid B ool o| e
T Y TR S

Do not put any stray marks anywhere on the answer sheet. Use of any other paper, calculating machine, mobile
etc, is prohibited and will lead to disqualification.

FUC APl Rt f oy W U A W, A FA-GE S 2T SR e wiE wE #
Failure to adhere to any instruction given above will render your answer sheet as invlaid and it will not be
evaluated. ’

Tl F BITY F Ged g9 OO, I G F B TS A A 3 A 59 oL U.AR. I U #1 HEd e (et
) Y W mEM AF @ EEA

Please hand over the OMR answer shet to the invigilator befor leaving the examination hall, you may take the
carbon copy (Student's Copy) of the OMR answer sheet with you.




